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System

 ● This user manual refers to models FMT-080, FMT-200, and FMT-400.
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Key Features

FastMT is an automated fiber optic inspection system that partners state-of-the-art hardware 
with revolutionary software. The FastMT fiberscope images and processes each fiber based on 
a set of rules and criteria that meets IEC compliance or custom certifications. All fibers are in 
crisp focus, whether you are using an 80x, 200x, or high-resolution 400x model. 

The LabVIEW®-based software is intuitive and easy to use...no more scrolling from fiber 
to fiber! Each connector is inspected in a matter of seconds and the pass/fail results are 
independent of operator use. Complete with single page printable reports, FastMT helps 
manufacturers and end-users verify the quality of their connectors in a fraction of the time with 
repeatable, reproducible, and reliable results.

• Auto locate
•  Auto focus
• Auto pass/fail 
•  Customizable settings 
• Process MT-12 in as little as 12 seconds
• Display fibers simultaneously
• Single page reports for QA documentation
• Archived data and images
• Compatible with: MT, MTP®, LC, SC, QSFP, CPAK, PRIZM®-LT, MIL-Circular, and more!

Key Benefits
• Increase throughput
• Decrease labor costs
•  Operator independent
• Repeatable, reproducible, reliable results
• Eliminates supply chain friction

Your FastMT comes with several critical items. Make sure that you store all parts together, in a 
secure and accessible location. Do not throw away licenses or documentation. 

 ● Keep your NI License on file for reference and software re-installation. 

 ● Keep caging bolts in a secure but accessible location. 

FastMT

Caging Bolts

USB 3.0

NI License

Power Cable

Fixture

The FastMT is a benchtop 
fiberscope. Place it on a 
sturdy, level surface that 

won’t shake. 

One long, and one short 
caging bolt required for 

shipping and transporting 
your FastMT. 

The USB 3.0 cable connects 
the FastMT system to a 
desktop or laptop PC.

This is required for the 
operation of your software. 

A/C power cable connects the 
FastMT system to a standard 

3 prong outlet.

Each fixture is specially 
designed to hold a fiber optic 
connector securely in place 

during inspection.

1.1 Introduction 1.2 Item Checklist



Busy LED 
Pass LED 

Fail LED 

BACK PANEL:
• Power cable 

• USB cable
• Power switch 

• Model # • Serial #

Hand Screw

Zero Insertion
Force Opening

Positioning Notch
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FastMT is ready to use out of the box in just a few short steps. In addition to the fiber scope, you 
should have at least 1 (one) fixture, a laptop/desktop PC, keyboard, and mouse. Refer to the Quick 
Start Guide to learn how to start your FastMT system.

Caging Bolt (left)

Caging Bolt (right)

Inspection Window

Power LED 

Ambidextrous Toggle

Basic

Size 5.25in x 5.25in x 12in  (13.34cm x 13.34cm x 30.48cm)

Weight 12lbs (5.44kg)

Connection USB 3.0

Power 110V / 2A

PC Requirements • Quad Core i7
• 16 MB RAM
• 512 GB HDD
• Windows 7 or Windows 8.1
• USB 3.0 Port Using FTDI Chipset

Lens & Camera

Field of View • FMT-080: 9.2mm x 12.8mm
• FMT-200: 2.31mm x 3.22mm
• FMT-400: 1.54mm x 1.1mm

Resolution • FMT-080: 2.09um / pixel
• FMT-200: 0.835 um / pixel
• FMT-400: 0.418 um / pixel

Support

Phone Support Free for 90 Days. 
Call (855) 323-4237 for troubleshooting.

Warranty One (1) Year

RMA Contact sales@fiberqa.com to return, replace, or repair product(s). 

Troubleshooting Visit us online at www.fiberqa.com for education and video tutorials, or 
contact support@fiberqa.com for more help. 

1.3 Hardware 1.4 Data Sheet

WARNING
Remove CAGING BOLTS prior to powering system on. Re-install caging 
bolts after shutting the system down, and prior to shipping. Shipping or 
transporting your FastMT without caging bolts will VOID your warranty. 

http://www.fiberqa.com


10  FASTMT OVERVIEW

Remove caging bolts.
Using the small wrench provided, unscrew bolts counter-
clockwise on either side of the open inspection window. 
Store in a safe, secure place, as you will need to use the 
bolts again when shipping or transporting your FastMT.

1.

Power on FastMT.
On the back panel of your FastMT, locate the ON / OFF 
switch. Toggle the switch to the ON position. The blue 
power LED on the front panel will light up.

3.

Launch FastMT software.
Once you have launched the program and initialization 
functions are completed, the busy LED on your FastMT will 
turn off. You can now attach a fixture and begin testing.

5.

Plug in power cord.
First, plug the power cord into the back of your FastMT. 
Then, using the 3-prong end, insert into an electrical outlet 
or appropriate outlet adapter.

2.

Plug in USB cable.
The FastMT ships with a USB 3 A to Micro B cable. Plug the 
USB microB end of the cable into the back of the FastMT. 
Then plug the USB A end of the cable into your laptop or 
desktop PC.

4.

2. Software Basics

1.5 Quick Start Guide
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2.1 Toolbar

The Toolbar provides easy access to the basic functions needed to operate a FastMT.

Button Description

Fixture Login

Clicking the button brings up a dialog to select the current fixture. The operator 
must login the fixture whenever a new fixture is installed. The test configurations 
can also be selected or edited before clicking Process. See section 3.3 Choosing a 
Test Configuration for more.

Exposure
Clicking the  button brings up a dialog for advanced exposure control. The + 
and - controls increase/decrease the exposure. A bold box will highlight the button 
when ON. See section 3.6 Setting the Exposure for more.

Ferrule/Fiber View
Clicking the selector toggles between a view of the whole ferrule and cropped 
images of the fibers.

Live
Clicking the button toggles between still mode (Live OFF) and continuously updat-
ing (Live ON). 

Auto-focus
Clicking the button initiates a fine focus operation.  If the starting point is outside 
the range of motion of the fine focus, then a wide focus is initiated, automatically 
followed by a fine focus for the best possible image.

Align & Focus

Clicking the button initiates an auto align process in relation to the pin/hole for 
accurate x-centering of fibers. The fibers are then located and auto-focus is per-
formed. The small button to the left of the Align & Focus button enables/disables 
the automated align and focus function when either the capture or process but-
tons are clicked. See section 3.4 Aligning the Image for more.

Button Description

Capture
Clicking the button initiates a full image capture and storage without processing. See 
section 3.7 Image Acquisition & Processing for more.

Process
Clicking the button initiates a full pass/fail test with processing. See section 3.7 Image 
Acquisition & Processing for more.

Process Progress
Indicator bar provides information about the current system status: Idle, Aligning, 
Focusing, Fine Focus, Acquiring, Processing, Pass, Fail.

Indicator Description

Fixture Name/# Fibers/
Test Configuration

Provides basic information about the fixture being used, the part being inspect-
ed, and the test configuration being used.

Data Key Entry

There are two or three fields displayed that show the data storage keys. How 
many items and what keys they are depend on the “Folder Structure” settings. 
See section 4.3 Save Image Preferences for more. 
(Note: Part/Serial format are controls for data entry. Make sure the correct data 
is entered prior to clicking the Capture or Process button. For other modes, a 
dialog pops up for data entry when Capture or Process is clicked.)

Toolbar continued...
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2.2 Menus
There are several different menus above the toolbar that assist in controlling FastMT. 

Menu Item Key Description

Save Ferrule Images Ctrl + S Saves ferrule image as a .PNG file to a selected location

Save Image Preferences Ctrl + I
Allows the operator to choose which images are saved during cap-
ture and process events. Folder structure and location can also be 
configured see section 4.3 Save Image Preferences for more.

Browse Fiber Images Ctrl + B
Opens the Windows Explorer view of the root directory where imag-
es are located. This feature allows the operator to navigate and view 
all of the exported images and data created by the processing.

Find Last Saved images Ctrl + L
Brings up a Windows Explorer view of the last processed image set. 
Once at this location, you can use standard Windows file features to 
view all of the exported images and data created by the processing.

Enable Processed Table 
Results

Ctrl + R
Enables/disables creation of Processed Table Results within the 
Single Fiber View panel. Disabling this function will provide faster 
performance. See section 2.3.4 Processed Results Tables for more.

Quit Ctrl + Q Exits out of the program.

2.2.1 File Menu

The File Menu has several different save, browse, and preference options for the 
fiber and ferrule imaging.

Menu Item Key Description

Cut Ctrl + X Standard editing tool cuts selected text from document.

Copy Ctrl + C Standard editing tool copies selected text.

Paste Ctrl + V Standard editing tool; pastes copied or cut text into selected text.

Test Configuration Ctrl + T
View, edit, and create test configurations. This includes editing/
defining Part Parameters, Processing Settings, and Zone/Rule defini-
tions. See section 4.1 Test Configuration Panel for more.

Test Config Password N/A
Enables password protection to lock test configurations. The 
number of password attempts can be specified. Once the limit is 
reached, the program will initiate a system shut down.

Preferences Ctrl + ,
Displays various functions within the FastMT program, which 
includes Acquisition, Processing, Reporting, and Custom Fiber. See 
section 4.2 Preferences Panel for more.

Overlay Off? Ctrl + O Enables/disables the defect overlay feature.

2.2.2 Edit Menu

The Edit Menu provides several standard and custom options for editing configura-
tion and preference changes.
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Menu Item Key Description

Control Front Ctrl + F
Manually enables/disables the Front LED. A checkmark will appear 
when the LED is enabled. Clicking on the feature will uncheck the 
box and disable the LED.

Control Back Ctrl + B
Manually enables/disables the Back LED. A checkmark will appear 
when the LED is enabled. Clicking on the feature will uncheck the 
box and disable the LED.

Enable Front 
(Capture/Process)

Ctrl + Shift + F

Automatically enables/disables the Front LED when Capture or 
Process is initiated. (Note: Even if Control Front is disabled and the 
LED is OFF, it will turn ON during Capture and Process when en-
abled. When disabled, the LED will only be ON while Control Front 
is enabled.) 

Enable Back 
(Capture/Process)

Ctrl + Shift + B

Automatically enables/disables the Back LED when Capture or 
Process is initiated. (Note: Even if Control Back is disabled and 
the LED is OFF, it will turn ON during Capture and Process when 
enabled. When disabled, the LED will only be ON while Control Back 
is enabled.)

2.2.3 Light Menu

There are two separate LED’s associated 
with the FastMT.  The Front LED is internal 
to the FastMT and provides illumination 
for viewing the ferrule and fiber(s).  The 
Back LED is an optional external light 
source which illuminates the fiber(s) from 
the distal end of the cable.

Enabling both front and backlight allows imaging of the structure around the part 
(using the front light) as well as through the fiber core (back light).

Disabling the Front LED with the Back LED enabled is a good way to test for cable 
continuity to ensure there are no breaks in the fiber(s). 

Enabling only the Back LED also allows the operator to directly observe the effective 
illumination area on lens-based connectors to measure the beam response.

Menu Item Key Description

Jog Panel Ctrl + J

Opens up the Motion Jog and Manual Fiber Fit panel. This dialog 
provides two sections of functionality: the Jog motor’s control 
panel manually positions all axes of motion of the FastMT, while 
the Manual Fit (Overlay Image) control panel manually adjusts 
the Find Fiber grid. See section 5.3 Manual Fiber Fit for more.

X Center Ctrl + Shift + X Moves the camera to the midpoint of the x-axis.

Z Center Ctrl + Shift + Z Moves the camera to the midpoint of the z-axis.

Save Focus Images N/A

Saves the focus images and selects the destination folder. A 
check mark will appear next to “Save Focus Images” in the menu 
bar to indicate it is enabled. To disable this feature, select “Save 
Focus Images”. The check mark will disappear when disabled.

2.2.4 Align Menu



18  SOFTWARE BASICS SOFTWARE BASICS  19

Menu Item Key Description

Enable Manual Fiber Fit? Ctrl + Home
Turns on or off the “Show Manual Fiber Fit” menu 
option. A check mark will appear next to the “Manual 
Fiber Fit” in the Ferrule View options panel. 

Show Manual Fiber Fit Window? Ctrl + G
Opens the Jog and Manual Fiber Fit dialog box. 
See section 5.3 Manual Fiber Fit for more.

Test Target Mode Ctrl + Shift + T

Switches exposure to the “Low Exposure” stored in the 
motor. It is called Test Target, because low exposure 
is usually required to correctly image the FiberQA test 
target.

Auto Exposure Mode Ctrl + Shift + E

Enables/disables an automated process that de-
termines the best exposure settings related to the 
current fiber under test. See section 3.6 Setting the 
Exposure for more.

Set Camera Tap Gains N/A
Sets the highest limit of exposure. See section 5.4 Set 
Camera Tap Gains for more.

Set Camera Tap Gains Low N/A
Sets the lowest limit of exposure. See section 5.4 Set 
Camera Tap Gains for more.

Enhance View Ctrl + E

Enables/disables contrast improvement of the fiber 
image by making an image processing-based adaptive 
leveling of the intensity across the face of the fiber 
(available for FMT-80 and FMT-200 ONLY). This can 
be helpful with brightly illuminated cores and will help 
accentuate low contrast defects. See section 5.2 Con-
trast Enhancement for more.

Enhancement Increase Ctrl + =
Increases the degree of enhancement being applied.  
See section 5.2 Contrast Enhancement for more.

Enhancement Decrease Ctrl + -
Decreases the degree of enhancement being applied. 
See section 5.2 Contrast Enhancement for more.

2.2.5 Ferrule Menu

Menu Item Key Description

User Manual Ctrl + U
Opens a copy of the user manual, which can also be opened 
through the Windows “Start Programs” shortcuts.

Operator Training N/A
Opens operator training information, which can also be opened 
through the Windows “Start Programs” shortcuts.

Backup User Settings N/A Not currently available.

Restore User Settings N/A Not currently available.

Restore Factory Defaults N/A Restores all settings and preferences to original factory defaults.

Show Tip Strips N/A
Enables/disables information text that appears when the mouse 
hovers over a button or indicator.

About Ctrl + A Displays which software version of FastMT is currently operating.

2.2.6 HDR Menu

Enables/disables the HDR (High Dynamic Range) image processing. See section 5.1 
HDR Imaging for more.

2.2.7 Help Menu

The Help Menu provides access to documentation, user settings, factory defaults, 
and software information.
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2.3.1 Ferrule View

In Ferrule View, the entire live or captured image is shown. This is the best view for 
making initial adjustments for centering and making sure the fibers are in the field 
of view (FOV) during the first use of the system, and upon switching fixtures. (Note: 
while using a FastMT-400 in live mode, the operator will only see the leftmost fibers 
on the ferrule, as multiple images are required to process the entire ferrule.)

2.3 Image Viewing Area
The Image Viewing Area makes up the majority of the GUI panel. This is where the 
image(s) of the ferrule (and individual fibers) being tested can be seen. 

There are several different viewing options. Understanding the different views before 
operating a FastMT is important. 

The operator can switch between Ferrule View and Fiber View by toggling the button 
selector (see below), located in the Toolbar. 

Once the ferrule is processed, data tables are also displayed within the image view-
ing area. 

Zooms in (left mouse click) and zooms out (Shift + left mouse click).

Moves image around while zoomed-in by clicking and dragging the mouse.
Zooms into a specified area defined by the selector tool.

2.3.1 Ferrule View continued...

There are several options to adjust the image prior to processing:

Scales the image to fit within the viewing area.
Enables/disables the green box overlays identifying 
the captured fibers on the ferrule.

Enables fiber extraction by manual adjustment by 
using the Jog and Manual Fiber Fit interface.

Utilizes the maximum camera width and height to 
view the entire ferrule. When not selected, the small-
est view possible is utilized to enable faster inspec-
tion speeds and reduced data storage (if ferrule 
images are stored).

2.3.2 Fibers View

The Fibers View provides an overview of all the fibers located on the ferrule. In or-
der to view the fibers at the largest possible display size, the individual fibers are 
cropped into square images and arranged in a grid. The size of the grid will change 
based on the numbers of fibers; from a 1x2 for 2 fibers, up to 6x12 for 72 fibers. 

Processed ferrule in Fibers View (FMT-200)
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2.3.3 Single Fiber View

Clicking on any one fiber while in Fibers View will show the individual fiber in Single 
Fiber View. The fiber is shown on the left hand side of the Image Viewing Area. 

Operators can switch between individual fibers by selecting a fiber from the ferrule 
key (red dots indicate failed fibers, green dots indicate passed fibers) located below 
the fiber images, or by navigating from fiber to fiber using the arrow keys (left and 
right).

Fiber Key Overlay On/Off

Fiber Scrolling Arrows

Processed Results Tables

Processed fiber shown in Single Fiber View (FMT-200)

2.3.4 Processed Results Tables

The Single Fiber view includes a set of tabbed data structures to the right of the fiber 
image. These structures include data on Part Info, Rules, 
Metrology, Particles, Edge Chips, Scratches, Occluded 
Area, and Timing. You can enable these tabs by selecting 
Enable Processed Table Results from the File Menu. 

You can freely move among the tabs to look at the col-
lected and curated data. 

Clicking on a defect in the fiber image will reveal more detailed information (size, 
location, etc.), shown in a display area below the image. 

When a defect is selected (particle or scratch), the corresponding tab is automatically 
selected, with the row of data for that defect selected and highlighted. 

The data is also stored in spreadsheets located in the Images Directory available 
after each test.

Processed Results Tables: Part Info Tab (left) and Rules Tab (right)



3. FASTMT OPERATION
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The fixture is secured to the front panel using two captivated thumbscrews, 
hand-tightened turning clockwise (to the right).

A groove is located on the bottom left of the fixture. This groove rests on the station-
ary front panel pins, helping the operator locate the correct x-position (set by the 
groove), y-position, and roll angle (combinations of the two pins). 

When placing the fixture on the pins, DO NOT force it 
left/right. As you hand-tighten the screws, let gravity 
pull it down on the centering pins, or push down light-
ly on the top of the fixture to ensure correct place-
ment. The z-plane (position, pitch, and yaw angle) is 
set by interface between the flat faces of the back of 
the fixture and the front panel of the fiberscope.

3.1 Installing a Fixture

3.2 Installing a Connector

Press and hold down on either the left or right side of the lever located on the 
fixture. Insert the connector into the opening. 

Hold the connector securely in place while 
releasing the lever to secure connector in 
place.

To remove the connector, press down on 
the same lever to release tension on the 
part and remove carefully. 

Continue to insert subsequent connectors in the same manner. This will minimize 
the need to realign the fixture for each connector tested.

WARNING
Removing the part without pressing and holding down on the lever may 
damage the connector and cause wear and tear on the fixture.

Select the Fixture Login button  from the Toolbar. Follow the prompts to properly 
select the fixture being used and the configuration required for testing the part(s).

1. First, you must choose the Ferrule Type. Making a selection will populate the 
Choose a Fixture menu with applicable fixtures. The list of available Test Configura-
tions will update automatically.

2. Next, you must select a fixture from the Choose a Fixture menu. Making a selec-
tion will populate the How Many Fibers? menu with applicable fiber counts.

3. Select the number of fibers located on the ferrule type being inspected from the 
How Many Fibers? menu. Custom counts can be specified by selecting the Custom 
Fibers box, and clicking the Custom Fibers button.

4. Confirm that the desired Test Configuration is selected from the menu. You can 
either choose a different configuration from the menu, or you can add a new Test 
Configuration if needed. See section 4.1 Test Configuration Panel for more.

5. Ferrules with multiple rows can have different Test Configurations assigned to 
each row by selecting the Multi-Row Configuration box.

Your system is now ready to capture images and process them according to the 
selected configuration.

3.3 Choosing a Test Configuration

Fixture Login Panel

1

2 3 4

5
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3.5 Focusing the Image

Select the Auto Focus button from the Toolbar if the image is out of 
focus. Auto Focus performs a combination of wide and fine focusing 
operations to achieve the clearest image possible. 

3.4 Aligning the Image

Alignment should be conducted when a new fixture is mounted to the FastMT and 
the Test Configuration has been selected.

If the button to the left of the Align & Focus button is “ON” (green), the FastMT sys-
tem will automatically perform an Align & Focus operation when either the Capture 
or Process button is clicked. If Auto Align & Focus is ON, you may skip the next step.

Toggling the button “OFF” (gray) will disable this feature, and the 
Align & Focus button will have to be clicked independently from 
the Capture and Process buttons.

 ● Select the Align & Focus button from the Toolbar. The Align & Focus 
button will perform an alignment of the part before continuing with the 
Auto Focus. 

Fibers in Ferrule View out of alignmentFibers after alignment (FMT-400)

3.6 Setting the Exposure

Optimal Exposure can be set automatically or manually. Ideally, the intensity in the 
Cladding Zone should be about 127 (mid-range).

Bright reflection in the core can limit cladding intensity to a lower value, as it is criti-
cal that the highest level for non-defect regions be below 255 (240 is nominal maxi-
mum). 

If the image is too dark (underexposed) for the fibers to be visible, you will need to 
set the Exposure. If the image is clear, you can skip this step.

Click the Manual Exposure button in the Toolbar to bring up the 
Set Exposure dialog. This dialog allows the operator to manually 
adjust the exposure level. 

Use the intensity readout near the image in Ferrule View or Single 
Fiber View while pointing to an area of interest (Cladding or Core) as feedback for 
achieving the correct exposure.

To learn how to manually adjust the exposure to process bright cores using HDR 
Imaging, go to section 5.1 HDR Imaging.

3.6.1 Setting Manual Exposure

Select and enable the Auto Exposure Mode from the 
Ferrule Menu. Then click Capture or Process.

The system will automatically run four acquisition 
and processing steps to calculate the best exposure, 
and sets this as the exposure value. To get the best 
results, start with the exposure slightly darker than 
normal.

3.6.2 Auto Exposure
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3.7 Image Acquisition & Processing

Click the Capture button to conduct a simple image acquisition, or 

Click the Process button to run a complete pass/fail inspection.

The next steps will occur automatically when either the Capture 
or Process button is clicked:

 ● Operator may be prompted to enter UUT information. 

 ● Align + Focus (if enabled).

 ● Acquire ferrule image(s) (idle indicator will change to “Acquiring”). 

 ● System segments out individual fibers.

 ● If the Process button is clicked, the application will test and measure each defect against the 
limits determined in Test Configurations for a “Pass” or “Fail” determination.

 ● Once an image is acquired, it is passed off to multiple processing engines. As individual fibers 
are processed, the indicator will change to a green for “Pass” or red for “Fail,” and will not 
change back to green.

 ● More overlay details are added to show the 
defects and fiber metrology information.

 ● Images are stored as defined in Save Image 
Preferences. See section 4.3 Save Image 
Preferences for more. 

FastMT-080 and FastMT-200 models acquire the entire ferrule in a single image. 
FastMT-400 models acquire three separate images of the ferrule in order to achieve 
the highest resolution image of each fiber.

3.7.1 Model-Specific Processing

ST fiber in Ferrule View

Only the FastMT-400 model can acquire and process images from single fiber fer-
rules, such as LC or SC connectors. FastMT utilizes the terminology “Single Termini” 
(ST), but “Single Fiber Ferrule” and “Ceramic Fiber” are considered synonymous alter-
natives.

 ● Select the ST Ferrule Type on the Fixture Login panel. As with other Ferrule Types, only those 
Test Configurations and fixtures that apply are then shown for selection. The number of fibers 
will always be pre-selected as “1” for the purpose of ST inspection. (Note: For ST ferrule types, 
the Test Configuration includes the additional zones for the contact region and epoxy ring.)

 ● Complete the remaining Capture or Process protocol the same way as you would a multi 
termini ferrule. 

3.7.2 Single Termini (ST) Processing

3.8 Processed Data Files

FastMT automatically stores images for each Capture or 
Process operation. When processing, additional images 
and data files are created and stored. 

These images and data files are arranged in a 
well-organized structure that uses the data keys (Lot, 
Part, and Serial Number) that identify a given part and 
the date/time stamp of the current test. 

Processed ST fiber in Fiber View
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A root folder for the data and image storage can be selected for each key type (Lot/ 
Part/Serial, Part/Lot/Serial, or Part/Serial).” to “(Lot/ Part/Serial, Part/Lot/Serial, Part/
Serial, or Part).

Tests are stored using Lot/Part/Serial keying, 
under the default FastMT Images root 
directory. 

The serial number is always used for the lowest level folder name for a given part. In-
side each Serial Number folder, there can be one or more Test folders, whose names 
are automatically created based on date and time of the test. Each of these will con-
tain the Captured and/or Processed images and data.

The contents of the Test folder will depend on the type of acquisition (Capture or 
Process) and the settings selected in the Save Image Preferences. See section 4.3.1 
Image Files Tab for more. 

Inside the Test folder there are two folders created during the image 
capture process: Ferrule and Fiber. These folders organize the ac-
quired images into Process and Viewable folders. 

Process files are used by FastMT for fiber end face processing. If the 
fibers are processed, then there will be nine additional folders within the 
structure: 

 ● Six image folders: Edge Chips, Leveled, Overlay, Particles, Raw, and Scratches (all with Cropped 
pre-pended)

 ● Three data folders: Data Log (used internally), Spreadsheets, and Timing (contain ASCII 
spreadsheet files with the Occluded Area, Defect and Rules detailed data and Test Timing data).

Viewable versions are useful when including images in reports. 

32

3.8 Processed Data Files continued...

NOTE 
For clarity, the tags “Lot Number”, “Part Number”, and “Serial Number” have been added to the names 
in this example. You do not have to do this, and the program does not automatically add these prefixes.

3.9 Shutting Down

1. Quit the application from the File Menu.

2. Disconnect USB cable.

3. Flip the power switch to the “OFF” position.

4. Unplug power cable.

5. Shut down or reboot PC (optional).

6. Remove fixture (optional).



4. SETTINGS & PREFERENCES
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A Test Configuration is a set of parameters that 
controls how the system’s processing finds fibers 
and defects, measures defects, and compares de-
fects to zone based rules to ultimately determine 
the Pass/Fail status of a fiber/ferrule.

The Test Configuration panel can be opened from 
the Edit Menu. The panel provides several tabs that 
organize the data parameters into logical groupings. 

In most cases, selecting an option will bring up a dialog that guides the operator 
through the steps to complete the requested action. For example, if the Open option 
is selected, a dialog appears that provides a drop down menu to pick any of the pre-
viously created configurations.

Once a Test Configuration has been selected, FastMT will continue to use it, even 
across power cycles, until the operator selects a different one. The Test Configura-
tion used for processing fibers is included in the header information in the detailed 
results spreadsheets created for each test to ensure traceability.

From the File menu, configuration settings can be imported and exported, opened, 
saved (to current or a new configuration), reverted to the last saved configuration, 
and deleted. 

4.1 Test Configuration Panel

NOTE 
There is a Report feature which generates customizable test configuration reports in 
Microsoft Excel; however, this is currently an unsupported feature.

The  Simple Tab has three sections for setting parameters that control defect detec-
tion related to the Fiber, Ferrule and the Occluded Area. 

There is also a section for adjusting the Metrology Contrast, which provides differ-
ences in intensity levels used to identify the core-to-cladding and cladding-to-ferrule 
boundaries.

Metrology Contrast
 ● Core to Cladding contrast sets a difference between the intensity in the core relative to the 

cladding. This is the minimum contrast required for the software to detect that there is a core 
illuminated enough for detection.

 ● Cladding to Outside Edge contrast sets 
a difference between the intensity in the 
cladding relative to the outside edge. This 
is the minimum contrast required for the 
software to detect that the cladding is illuminated enough for detection.  Typically adjusted in 
increments of 5.  The best nominal value is between 20 and 30.

4.1.1 Part Parameters Tab

Operator can select either Multiple Termini (MT) or Single 
Termini (ST), or Prizm based on the part being tested.

Example image of part being tested will auto update once 
the Ferrule Type has been selected.

The Cladding and Core Diameters are used to make sure 
the found fiber parameters are close to expected values.

PC/UPC or APC can be selected for the part being tested.
APC angle is enabled when APC mode is selected. The default 
angle is 8 degrees, but can be changed if needed.

4.1.2 Processing Settings  - Simple Tab
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4.1.2 Processing Settings - Simple Tab continued...

Process Fiber
Fiber processing can be enabled/disabled. This section consists of three defect type 
subsections—Particles, Scratches, and Edge Chips. 

 ● Particles processing can be selected to process “Light & Dark” particles, “Light” particles only, 
“Dark” particles only or “None” for no particle 
processing. The following parameters specify 
how defects are processed:

 ● Min Diameter/Width (um) determines 
the minimum particle diameter or width 
to exclude from reporting.

 ● Light Contrast specifies the degree of 
contrast that the particle is brighter than 
the cladding/core background.

 ● Dark Contrast specifies the degree of contrast that the particle is darker than the 
cladding/core background.

 ● Scratches processing can be selected to process “Light & Dark” scratches, “Light” scratches 
only, “Dark” scratches only, or “None” for no scratch processing. The following parameters 
specify how defects are processed:

 ● Min Diameter/Width (um) determines the minimum scratch diameter or width to 
exclude from reporting.

 ● Light Contrast specifies the degree of contrast that the scratch is brighter than the 
cladding/core background.

 ● Dark Contrast specifies the degree of contrast that the scratch is darker than the 
cladding/core background.

 ● Edge Chips are particles that touch the outside edge of the cladding. Edge chips can be 
enable/disabled with the following parameters are used to them: 

 ● Min Area (um^2) of the detected particle.

 ● Min Radial Thickness (um) of the detected particle.

NOTE 
More defects will be found as the contrast setting is lowered. This can result in defects being grouped 
together which should be treated separately. Conversely, the higher the contrast, the fewer defects found.  
This can result in scratches being missed. Additionally, reporting specifies particle defects, but does not 
differentiate between light or dark scratch defects. 

Process Ferrule - Particles
Only available for Single Termini (ST) ferrules, and are not selectable for all other fer-
rule types. This processing can be enabled or disabled at the discretion of the oper-
ator. The following parameters can be 
selected for particle detection:

 ● Max Number is the maximum or 
particles processed

 ● Min Contrast is the threshold level at 
which the defect is considered to exist

 ● Max Area (um^2) is the maximum size of a particle area allowed.

 ● Min Size (um^2) is the minimum size of a particle area allowed.

Process Occluded Area
This is the total number of detected defective pixels 
of whatever type you have.

 ● Weighted Formula supports the Weighted Occluded 
Area detection. This control provides the ability to create 
or edit the occluded area formula and define any function 
of radius. The default function is the Gaussian weighted 
beam response, which is typical of single mode and most 
multimode fibers.  Defects found closer to the core are 
given a higher value since beam strength is strongest and 
therefore impacted by defects closer to the core.

 ● Settings for occluded area are:

 ● Mode Field Radius (um) is typically ½ the core diameter.

 ● Minimum Particle Diameter (um) specifies the minimum particle diameter.

 ● Minimum Scratch Width (um) specifies the minimum scratch width.

 ● Include allows the operator to individually select Particles, Scratches and/or Edge Chips for 
occluded area processing.

 ● Process Zone Occluded Area can be enabled to process the occluded area by using one of 
two methods:

 ● Strict Zones selects occluded area for each of the defined zones

 ● Zones Masked by Cladding: The actual cladding diameter will be used as a mask for fibers 
with darker outside areas as a result of manufacturing processes.

4.1.2 Processing Settings - Simple Tab continued...
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4.1.3 Processing Settings - Advanced Tab

This tab has several sections for setting advanced processing parameters, which the 
operator should not alter without instruction from FiberQA. The only exceptions are 
the following two parameters:

Metrology
Cladding Search Width puts a limit on how far we can deviate from the ideal cladding diameter 
and what we find as the cladding diameter.  Nominal is 15um but the operator may need to adjust 
depending on the cladding-to-ferrule characteristics.

Scratch 
Minimum Length of the Line Thresholds should be set to 15um, as anything less would be too 
small.

4.1.4 Zone/Rule Tab continued...

The operator can assign any name using alphanumeric characters. However, it is 
customary to keep the names short and/or to match the names in a given standard 
being implemented. The description is provided to allow for more context. While 
FastMT allows overlapping zones, the zones typically share common boundaries.

Adding a New Zone
Zones can be added within the Zones Table using two methods:

1. Select the zone in which you would like to insert your new zone before. With 
this zone selected Right-Mouse-Click and select Insert Element Before. An empty 
zone entry will appear. In this area type in a name, inner and outer diameter and 
optional description. Be sure to make the Zone name different from any existing 
names (a warning appears if a duplicate is detected). Select Save from the File 
menu. A warning will appear if you try to insert a new zone before a zone with 
existing dependent rules. In this situation, the new zone must be implemented 
using the second method below.

2. Scroll to the bottom of the Zones table, and observe a grayed out empty zone 
entry. In this area, type in a name, inner and outer diameter and optional de-
scription. Be sure to make the Zone name different from any existing names (a 
warning appears if a duplicate is detected). Select Save from the File menu.

Editing Parameters
To replace the parameters of an existing Zone, click on its entry in the table. Make 
any changes required, and then select Save from the File menu.

Deleting Zones
To delete a Zone, select it in the table, then right-mouse-click and select Delete El-
ement. An attempt to delete a Zone already in use by one or more rules will not be 
allowed. A warning dialog will appear, notifying the operator that all rules that use 
that Zone must be deleted before the zone can be deleted. 

The Zone/Rule Tab is used to add, replace, edit, and delete Zones and Rules. 

Zones
Zones are circular regions centered on each fiber (shown and 
labeled in the example to the right). Different rules may be 
created to apply unique pass/fail criteria to defects, based on 
which zone the defect is found in.

There are four parameters associated with each zone that can 
be edited: Zone Name, Inner Diameter, Outer Diameter, and an optional Description. 

4.1.4 Zone/Rule Tab
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4.1.4 Zone/Rule Tab continued...

Rules
Any number of rules can be defined as needed. Each rule, in turn can have multiple 
tests. The Rules Summary Table is a list of the currently defined rules that can be 
used to select a given rule for operation based on the button selection. There are 
buttons located to the left of the table for Add Edit  and Delete  . 

The Rule Details table shows the entire list of rules, with the parameters used to cre-
ate a description of the rules. Each rule begins with the user supplied rule name. 

When either the Add or Edit Rule button is selected, the Configure Rule dialog ap-
pears. This dialog is used to create or edit a rule. 
There are two sections to the panel, one for the overall parameters including name, 
zone and number of allowable defects and the test 
definition section. 

 ● Rule Title is a free-form text entry. 

 ● Zone provides a dropdown menu of the zones defined in the 
Zones Setup tab. 

 ● # of Defects Allowed is the maximum number of defects 
that can fail the tests without causing a failure of the rule. 
Stated another way, the number of failing defects must be 
at least one more than this number to fail the rule. Even though specific defects may fail the 
test criteria, it may not cause a test failure, while failing any rule will cause the fiber to fail.

NOTE 
Rule names are created by the user and may not accurately reflect the 
rule definition. A good practice when creating rules, especially if the name 
contains a short description of the intent, is to make sure the interpreted 
function matches the name.

Adding and Removing Rules 
Pass/fail rules can be created based on measurements from four different defect 
types; chips, particles, scratches, and occluded area; and several 2D fiber metrology 
measurements; core, cladding and epoxy ring geometry parameters. 

Each rule can consist of one or more tests, where the 
tests are comparisons of measurements to the limits 
selected in this section of the pane. Tests can be 
combined using either logical “OR” (any) or “AND” (all).

1. The defect or measurement type is selected from a dropdown menu. 

2. Once a measurement type is selected, the next dropdown will adapt to display the 
options available for that type. 

3. There are several types of limit operations: equals, not equals, less than, greater 
than, or with in a range.

4. The numerical indicator(s) at the far right accept the values for the limits. If a range 
is selected, a lower and upper limit control will be presented.

Clicking the Add Test button  will add a new test at the bottom of the list. Any 
number of tests, operating on any of the parameters may be created in a single rule. 
This can be used to create complex rules found in some customer criteria. 

Adding additional tests may also be used to refine the limit testing, adding additional 
parameters, such as contrast. The latter can be useful to combine multiple parame-
ters that must exceed unique limits, such as a particle diameter greater than a limit 
and particle contrast is greater than some limit.

Clicking the Remove Test button  removes one test from the bottom of the list.

Click  to save the rule, or click  to cancel.

1 2 3 4

4.1.4 Zone/Rule Tab continued...
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The Acquisition Tab includes advanced settings that control the 
acquisition processes of a FastMT system. These preferences come 
with factory defaults that should be left alone for most workflows. 
While these settings will rarely need to be altered, FastMT is a very 
customizable system, even for the most rare use cases. Customiz-
able settings include:

Wide Focus 
Wide focus is used when the system doesn’t have any idea where the focal point of 
the ferrule is located. Typically, this will occur when a new fixture is being used.

 ● Focus Images sets a large/coarse step size by taking a large number of images over a wide 
range (Distance Boundary). 

 ● Distance Boundary is a symmetrical range that determines how close to the positive and 
reverse limits of the total range of motion available to the system. 

Fine Focus 
 ● Focus Images number controls how many images are taken within the 

Focus Distance. As the number of images is increased, the step size is 
refined and it will provide a more focused image. Increasing the number 
of Focus Images will also increase the time needed to complete focusing. 

 ● Focus Distance is centered on the current location (z-axis). 

4.2.1 Acquisition Tab

The Preferences Panel can be accessed from the Edit Menu. The 
panel contains four tabs that control different preferences related 
to Acquisition, Processing, Reporting, and Custom Fiber Operations.

4.2 Preferences Panel

NOTE 
If the part being tested has more tolerance in its z-position you may find that you are frequently 
having to conduct a fine, followed by wide, followed by another fine focus. If this is the case, you 
will save time by increasing the Focus Distance (we recommend by a factor of two). If you start 
seeing variation in the focus quality, you may need to increase the number of Focus Images if you 
have increased the Focus Distance. The ratio of Focus Images to Focus Distance should remain 
nominally the same when increasing or decreasing the defaults.

Image Quality 
There are two controls that affect the “Live” view of fibers:

 ● Image Averages determines how many images are averaged 
before displaying the ferrule and/or fiber images. More images can 
reduce noise in the displayed image. (Note: increasing the number 
of images will slow the update rate of the live image.)

 ● Fiber Size View % sets the size of the extracted fiber images 
as a percentage of the cladding diameter in the current Test 
Configuration. Cropping the image using a lower percentage 
increases the screen size of the fibers in the Fibers View (all fibers at one time). Setting the 
value too low can result in cropping of the fiber area due to errors in the fiber center location.

Options 
Various options can be enabled/disabled by checking the corresponding box(es). 
Specific use cases may require disabling these features.

 ● Use Ferrule View can also be enabled/disabled from the front panel on the image viewing 
area.

 ● Auto Focus Capture lets the operator 
conduct a manual focus operation and 
capture an image without the system re-
focusing on an unwanted focal point. 

 ● Fast Focus conducts an auto-focus on the 
first image only (when more than one image 
is required) taken during acquisition. Each subsequent image will simply initiate a move along 
the x-axis without re-focusing. If the focus is worse on one or more bank of images, the part 
may not be squared. Disabling the Fast Focus feature will take longer to process, but will 
ensure a fully focused image for each fiber on a skewed part. 

 ● Show Alignment enables/disables alignment markings.

 ● Focus Threshold is a value used to verify the Fine focus is valid. A lower threshold should only 
be used if the texture/contrast of a ferrule is low or the intensity is low.

Find Fibers Average 
This is an internal proprietary setting that is used to segment 
the fibers to find the best location for the fibers to be 
extracted. 

4.2.1 Acquisition Tab continued...
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Clipping 
Controls the maximum value recommended when using Manual 
Exposure while setting a firm limit for Auto Exposure.

HDR 
Settings determine which HDR algorithm to use and the ratio of 
nominal cladding to core ratio to use. (See section 
5.1 HDR Imaging for more.) 

 ● Auto Fiber Fit Version provides a selection of algorithms 
to use.  The latest version is recommended.

 ● Exposure Ratio ___ : 1 is the ratio of the Nominal 
Cladding Exposure / Nominal Core Exposure.

Location Overlay 
Controls the location and size of the fiber ID. 

 ● Text color box indicates the text color

 ● Background color box indicates the chosen background color for 
the text.

 ● Transparent makes the text background transparent

 ● Size % indicates how much of the display area is covered by 
the text. A default of 15% works best, but can be increased or 
decreased as needed.

 ● Corner allows the operator to select which corner the text will be displayed. 

Result Overlay 
Controls where and how the “Pass” or 
“Fail” text is displayed. Checking the box 
enables/disables the feature. 

 ● Corner allows the operator to select 
which corner the text will be displayed. 

 ● Size % indicates how much of the display area is covered by the text. A default of 15% works 
best, but can be increased or decrease. Pass color box selects the color used for the ‘PASS’ 
result.

 ● Pass color box indicates the color used for a ‘PASS’ result. 

 ● Fail color box indicates the color used for a ‘FAIL’ result .

 ● Background color box indicates the chosen background color for the text.

 ● Transparent makes the text background transparent.

4.2.1 Acquisition Tab continued...

The Processing Tab has several options that can be enabled and disabled by check-
ing the corresponding box(es). These settings control the way the Metrology, Zone, 
and Defect Overlays are shown on the Fiber Images. 

Defects Overlay
 ● Show Particles/Scratches/Edge Chips? 

enables/disables highlighting found particles/
scratches/edge chips. Checking the “Encircle” 
box creates a 1 pixel boundary line around 
the defect, meaning the defect lies within the 
boundary line, but does not include the 1 pixel 
width of the line itself. 

 ● Show Metrology? enables/disables viewing 
the metrology on processed image overlays and 
labels for each area.

 ● Show Zones? enables/disables Even/Odd Zones (no set number 
of zones). 

Pass/Fail Overlay 
 ● Show Boundary Box enables/disables the box that surrounds 

each fiber after being processed that indicates whether or not 
it passed, failed, or was not found.  The width (in pixels) of this 
boundary box can be adjusted, as well as the color that each box 
appears. 

 ● Show Icons? enables/disables the pass or fail icons (√ or X) in the 
corner of each fiber box. 

Image Quality 
 ● Image Averages control determines how many images are 

averaged before displaying the ferrule and/or fiber images. If set too 
low, the processing time can dramatically increase and repeatability 
decrease. Leaving the default setting is ideal for optimal use.

4.2.2 Processing Tab

NOTE 
The “Enable Processing Engine(s)" box should ALWAYS be left checked.
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 ● Fiber Size View % sets the size of the extracted fiber images as a percentage of the cladding 
diameter in the current Test Configuration. Cropping the image using a lower percentage 
increases the screen size of the fibers in the Fibers View (all fibers at one time). Setting the 
value too low can result in cropping of the fiber area due to errors in the fiber center location.

Options
 ● Hide Processing Engines keeps them as background 

tasks. Un-hiding this feature can be useful when 
troubleshooting.

 ● Auto-Cancel on First Failure stops processing once the 
system fails a fiber, with no additional information provided 
for the rest of the ferrule. 

 ● Enable Press Button activates the PRESS button on the 
front of the FastMT unit to Focus and Process the current 
ferrule.

 ● Auto Focus Process enables/disables auto focus at the beginning of each Process. This 
feature should only be disabled in rare cases, mostly for research purposes, such as unusual 
parts requiring manual focus or repeatability tests to exclude effects of focus.

4.2.2 Processing Tab continued...

4.2.3 Reporting Tab

The Reporting Tab provides the necessary features for the customer to verify report 
capability as well as customizing report appearance and additional save locations.

Check Compatibility 
Verifies the installation of additional software required to generate reports.  The soft-
ware requires the use of Microsoft Word and PDFCreator.

Customer and Operator 
Information entered for traceability of each report.

Options 
Operators can customize how reports are generated, which template is used, for-
matting, and where the report(s) will be saved.

 ● Template (*.dotx) specifies the MS Word template document (*.dotx) which uses the Tag 
Words for data and Bookmarks for images.  

Formats 
Selects the report format, as well as image and text content format.

 ● PDF saves the report as a PDF document. This format requires that both MS Word and 
PDFCreator are installed.

 ● MS Word saves the report as a Word document. This 
format requires that MS Word is installed.

 ● HTML Folder saves the report in an HTML format.  

 ● Part Result Image saves all fibers to one part result 
image (*.png).

 ● Use Result Text provides part summary Pass/Fail text 
instead of an image.

4.2.3 Reporting Tab continued...
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Print If 
Enables the operator to determine when to print and generate each report, only 
if the result matches the selection of “Pass Only”, “Fail Only”, or “Pass or Fail”. 

Part Result Image Pad
Number of pixels specifies the amount of sep-
aration between each fiber image in the Part 
Result.

HTML Image Widths
Resizes images within an HTML report.

 ● FMT sets the FastMT logo width in pixels.

 ● PF sets the Part Result Pass-Fail logo width in pixels.

 ● PFA sets the Part Result Pass-Fail Alternate logo width in pixels.

 ● FQA sets the FiberQA logo width in pixels.

Copy Report to Folder
Enables/Disables the operator from identifying an additional location to save the 
test result report.

Part Result and Part Result Alternative
Provides the file locations of the Part Result and Part 
Result Alternative Pass/Fail images. These files can be 
in either the *.jpg or *.png file formats.

PDF Creator
Provides additional features for PDF report genera-
tion.

 ● Print Monitor Visible makes the PDF Creator print 
monitor visible at the time of printing.

 ● PDF Compression uses PDF compression with 
PDFCreator. Several types of compression PDF Creator 
supports can be selected with *.zip being the default.

 ● Check Timeout will wait up to the number of seconds for 
the PDF document to complete printing.

4.2.3 Reporting Tab continued...

Controls the display information related to ignored fibers (not acquired or pro-
cessed) within a ferrule.

Text Overlay
Enables/disables the text displayed for ignored 
fibers.

 ● Text color box selects the overlay text color.

 ● Background color box selects the text background 
color.

 ● Transparent enables/disables the background color.

 ● Corner location of the text within the fiber image.

 ● Size % sets the size of the text with respect to the size of the image.

 ● Text customizes the text written.

Image Background Color
Displayed in 8 bits, the background color can be adjusted by using the slider bar or 
typing directly into the numeric display. The lower the value, the darker the back-
ground. The higher the value, the lighter.

4.3 Save Image Preferences Panel

The Save Image Preferences Panel can be accessed from the File Menu. The panel 
has two functions: 

1. Selects the images to be stored for Capture 
and Process operations. The Folder Structure 
Tab is where the folder structure and base di-
rectory is set. The Image Files Tab is where the 
selections on which images to store are made.

2. Configure the data keys used to define the 
data storage file structuring.

4.2.4 Custom Fiber Tab
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There are three tabs, within the Image Files Tab, that are selected by radio buttons 
named Full, Minimal and Custom. Each tab has two sections of selection controls: 
one for Manual Save (Capture) and the other for Processing Save. 

Full 
Selects all file classes and types for both Capture (Manual Save) and Processing. 

Minimal 
Stores only the PNG fiber images for Capture and APD fiber images for Processing 
(since these are the required input to the Processing software). 

Custom
As its name suggests, this allows the end user to decide exactly which images to 
store. Again, the exception is that the APD fiber images must be saved for 
Processing.

There are three check boxes available to save additional images to support further 
analysis or troubleshooting:

 ● Save Pin/Hole When Found saves the alignment image of the Pin/Hole when it is found.

 ● Save Pin/Hole When Not Found saves the alignment image of the Pin/Hole when it is not 
found.

4.3.1 Image Files Tab

 ● Save HDR Intermediate Results saves both source images in addition to the HDR composite 
image. When disabled, FastMT will only save the final composite image. Enabling this feature 
provides additional verification information, but will store triple data. This feature is enabled by 
default. If operators wish to conserve data storage, the feature should be toggled OFF.  

There are two major classes of images stored in FastMT: Ferrule and Fiber Images.

 ● Ferrule Image is the entire image captured by the FastMT camera, which includes the 
fibers and empty space around and between the fibers. The only areas of the Ferrule Image 
inspected by FastMT are the fibers for MT connectors and the contact zone for ST connectors. 

 ● Fiber Images are extracted into a square region centered on the fiber. There are acquisition 
and processing settings that determine the size of the extracted region relative to the cladding 
diameter. These extracted regions, one for each fiber, are stored separately as the individual 
Fiber Images.

Within each class of image, there are two formats or types of images that can be 
stored:

 ● PNG (Portable Network Graphics) images can be read by most graphics and 
word processing software. The PNG files are compressed (using a lossless 
compression technique to avoid artifacts commonly seen in JPG files). However, 
there is some loss of quality compared to the APD files due to truncation to 
8-bits. 

 ● APD (a proprietary format from National Instruments) images are larger due 
to the Single Precision formatting and lack of compression. APD images cannot 
be viewed without software from National Instruments. APD fiber images 
are required for processing, so these are always selected for storage, which 
can additionally assist in making improvements to image processing and/or 
debugging.

4.3.1 Image Files Tab continued...
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The Folder Structure Tab selects the Image Directory, the data key method and pa-
rameter settings for minimum key lengths and clearing options. The part login dialog 
provides for an optional comment, whose minimum length and clearing property is 
also set on this tab. 

Each method of folder structure has its own root Images Directory, whose factory 
default location is located in C:\FastMT Images.

There are four methods available for directory structuring that allow for a folder hier-
archy with one, two or three levels.: 

 ● Both the Lot/Part/Serial and Part/Lot/Serial methods use the same three keys, but change 
the order of the primary key between Lot and Part.

 ● Part/Serial method uses only two keys and hence one less layer of folder hierarchy.

 ● Part method has only one layer of folder hierarchy. 

Each of the Data Keys (Lot, Part, Serial, and Comment) can have a minimum field 
length. Making the length greater than zero makes the entry a required one, en-
abling the OK button on the Test Login dialog. 

The Clear? checkboxes to the right of each Data Key determines if the last entry is 
always cleared each time the dialog is opened. Clearing, combined with a minimum 
length of one or greater, has the advantage of forcing the operator to consciously 
decide what to enter.

It is still possible to enter a value for an entry that has already been used. A reason 
to not force clear is if the same information is used routinely for subsequent tests. A 
classic use case is that the Lot and Part Number remains the same for a large num-
ber of units under test, but the serial numbers are unique. Clearing only the serial 
number so that the operator has to type or bar code a unique ID for each part, while 
keeping the previous Lot and Part number, actually improves proper data entry with 
less effort. 

FastMT always adds one additional folder in the hierarchy that is automatically given 
a unique name that includes the date, time, exposure time and number of averages. 
This ensures that even if you test using the same Data Keys, the previous Test Data is 
never over-written. This means you can store multiple tests of the same part, which 
could be useful for testing at multiple points in the manufacturing process.

4.3.2 Folder Structure Tab continued...4.3.2 Folder Structure Tab
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To use HDR Imaging, you need to set two parameters; the exposure for the cladding 
and the ratio of cladding to core exposure. To set up your system for testing fibers 
with bright cores, complete the following steps in order:

1. Make sure that HDR is disabled from the HDR Menu. If there is no check mark next 
to “HDR Enable”, it is already disabled and you may continue on to the next step. If 
you DO see a check mark next to “HDR Enable” just click to disable. This feature must 
remain disabled during the initial setup.

2. Set the exposure to a value where the cladding area only reaches 127 in intensity. 
This can be accomplished by acquiring a live ferrule image and then zoom in on one 
fiber. Move the mouse cursor in the defect free 
cladding regions (Top, Left, Right, and Bottom) 
and read the Image Information Intensity value 
(see images to the right). Since we only need to 
set the level to “about 127,” a mental estimate 
will be sufficient. 

3. Save the current cladding exposure value by 
writing it down or typing it in a notepad (exam-
ple below left shows the Cladding Exposure as 
12000).

4. Set the exposure to a value where the core area is not clipping, at or below 240 
is preferred. Using the Exposure Dialog window, review the Clip Meter to place the 
needle around 240 (example below right shows the optimal Core Exposure at 1000).

5.1 HDR Imaging
5. Save the current core exposure value by writing it down 
or typing it in the notepad. Calculate the ratio by dividing 
the cladding exposure by the core exposure.

6. Set the Exposure to the Cladding Exposure value calculated. 

7. Update the exposure ratio. Select “Preferenc-
es” from the Edit Menu. Locate the HDR section 
from the Acquisition Tab. Enter the Exposure Ra-
tio previously calculated (12:1 in this example). 
The Nominal Core Exposure should match the 
exposure calculated for the core. 

8. You can now enable the HDR feature by selecting 
“HDR Enable (Ctrl +D)” from the HDR Menu. Ensure 
there is a check mark next to the feature. 

The live image will now display an HDR image that exposes both the cladding and 
core properly (see example image below). To edit the composite image saving pref-
erences, see section 4.3.1 Image Files Tab: Save HDR Intermediate Results.

5.1 HDR Imaging continued...

FMT-400 in Ferrule View with HDR Imaging enabled
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5.2 Contrast Enhancement

The FastMT-200 has significant value as a 
scope for manual inspection, without using its 
automated processing. To make it even easier 
to identify defects, FastMT offers a live con-
trast enhancement method. Currently, this is 
an image processing-based method.

Contrast Enhancement can be controlled 
from the Ferrule Menu by selecting “Enhance-
ment Increase” or “Enhancement Decrease”. 

Enhance View Minimum Enhance View +3 Enhance View +10 Enhance View Maximum

The Manual Motion Jog panel and Manual Fiber Fit controls are combined into a sin-
gle dialog. 

The Manual Fiber Fit controls allow you to move, rotate and 
scale the spacing of the fiber find grid. This grid determines 
the segmentation of the fibers from the ferrule image. It 
should rarely, if ever be required, but is provided as a last 
ditch method of acquiring fiber images when the automated 
fiber find does not work. One “normal” exception use case is 
if the ferrule is extremely contaminated to the point where 
automated fiber finding is ineffective.

5.3 Manual Fiber Fit

Jog motors (left), Manual Fiber Fit (right)

This procedure is performed at the factory prior to shipment and should not need to 
be performed during typical use. 

However, when the exposure is set outside 
of the normal range, the image can exhibit a 
checkerboard-like pattern noise. If the oper-
ator begins processing outside the normal 
range of exposure, or if the tap gains get lost, 
then you may need to set/reset them. 

Operators can set the high and low tap gains 
from the Ferrule Menu, allowing the operator 
to remove pattern noise and the gain differ-
ential between the channels.

5.4 Set Camera Tap Gains

The Jog Motors section of the dialog is used to manually position all of the axes of 
motion in the FastMT. 

There are controls to move each stage in a forward or reverse direction by clicking 
the arrow keys. 

The step size for each click is set using the ring control, which has pre-defined step 
sizes. These are actually combo boxes allowing for typing in any step size desired. 

5.3 Manual Fiber Fit continued...

NOTE 
No current FastMT model includes a Y-axis, so the jog buttons and step size setting 
ring are greyed out and disabled for that axes. Also, the direction of X-axis controls 
on this panel is from the point of view of the motion system, not the camera. So, 
moving left will have the effect of moving fibers to the right.
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